
	  

	  

Analyzing REA Benthic Images  
(Stratified random sites) 
 
PLEASE READ: 
As of August 2014, this is the latest version of the SOP. Please note that this SOP only covers 
analysis of images from Fixed or Stratified Random sites. The SOP for analyzing images from 
Towed-diver surveys is found on a separate document (see Wiki page or contact Paula Misa).  
 
Please ensure that prior to analysis, all photographs have already undergone appropriate post-
collection processing in the field: That is, it is assumed that the photographs have been renamed appropriately, tagged, and 
cataloged in the appropriate folder within the V:\OPTICAL directory structure developed by the Data Management Team. If that is 
not the case, please contact Troy Kanemura before proceeding. 
 
The process of “Checking-out” the images to be analyzed via the CRED Wiki has been eliminated. The Benthic Image Analysis 
(BIA) coordinator will be responsible for allocating sites and a spreadsheet containing the site assignments will, instead, be emailed 
directly to each analyst. 

In addition, the BIA coordinator will copy the site assignment spreadsheet to the CRED Wiki, which will serve as an online tracking 
log. Each analyst is responsible for updating the tracking log on a daily basis (see Step 13).  

 
I. ANALYZING IMAGES via CPCe 
 
1. SET UP THE ANALYST FOLDERS 
  

a) Create a new analyst’s folder within  
 V:\OPTICAL\region\year\island\REA\FISH or BENTHIC\site\PHOTO_QUADS\ 
 
b) Rename the folder with analyst’s initials (e.g. KSM, HB, BVA). 
 

  ** Please be advised: 
 If this is your first time analyzing images for CRED, your analyst initials and your affiliated 
 institution (for non-CRED) need to be added by the Data Management team to the database prior 
 to analysis. Please contact Troy Kanemura to ensure that this information has been added. 

  
c) Within the analyst folder, create the following folders:  

 ADJUSTED 
 RESULTS  

  
The folder structure should look like the following screen shot: 

 

 
 
 



	  

	  

d) Ensure that the Site folder and associated images within the PHOTO_QUADS folder have been 
renamed based on the following naming conventions: 

  
  Site name: “3lettersiteinitial-3or4sitenumbers”  (e.g. HAW-487) 
  Image file name: Sitename_YYYY_AorB_indexingnumber.jpg  
              (e.g. HAW-487_2011_A_01.jpg) 
   

 *Stop 
If there are errors with the images and/or folder naming convention (e.g. sites not having the proper site initials, images 
not renamed using the appropriate naming convention) please do not analyze these images or correct any problems 
yourself.  Rather stop, and alert the Data Management Team (Troy Kanemura) or Paula Misa for guidance on renaming 
the affected directory/files, and proceed with the image analysis only after all naming inconsistencies are corrected.  Skip 
the photo set for now and proceed to the next photo set if a quick resolution is not possible. 
 
**Note: 
The image file name indexing number is always a 2-digit number with a leading 0 (e.g. 01, 04, 09) 

 
 

e) Copy the images to be analyzed from the PHOTO_QUADS (for photos from Fish REA) or A/B 
folders (for photos from Benthic REA) within the V:\OPTICAL folder hierarchy to the ADJUSTED 
folder.  

 
*Please be advised 
Only those photos in the ADJUSTED folder should be modified (e.g. color correction, CPCe analysis, etc.). The images in 
the site folder should be considered as noneditable originals. They may be copied but not modified 
 

 
2. LAUNCH Coral Point Count with Excel Extensions (CPCe) program and ensure it is version 4.12. 

To verify the software version, on the Help menu, select About CPCe. If version 4.12 is not installed 
on your computer, please install it as instructed here, or contact Paula Misa. 

 
If installing and/or running CPCe V4.12 or later for the first time, the computer display resolution must 
be set at 96 dpi or else the software may not run.   
To do so (assuming that you are running on Windows 7), 
 
a) Move the mouse to the Desktop and right-click, select “Screen Resolution” 
b) From the bottom, click on “Make text and other items larger or smaller” 
c) From the left panel, click on “Set custom text size (DPI)”. 
d) In the “Scale to this percentage of normal size” pull-down menu, select 100%. The text at the 

bottom of the ruler should read: “9 point Segoe UI at 96 pixels per inch”. 
 

 
3. Load the most recent CODE FILE, which is the CRED standard version of the file CPCe uses to 

create the classification selection buttons 
 

a) Click on Options from the menu bar 
b)  Select Specify code file 
c)  Navigate to V:\OPTICAL\ANALYSIS\CPCe_CONFIG  
d) Select the CRED_Str_benthic_codes_40.txt code file (when analyzing photos after 2013 or 

unless instructed to use the old code file), select Open.  
 
The different code buttons for classifying the benthos appear along the bottom of  the screen, grouped 
and color-coded by both Tier 2/3 and Tier 1 category, separated by non-functional black buttons. 
 

 
4. Open the images to be analyzed from the ADJUSTED folder in the V:\OPTICAL hierarchy. An entire 

transect of photos can be opened at one time. 
 



	  

	  

a) On the File menu, select Multiple images/file processing. 
b) On the drop-down menu, select Process multiple images. 
c) In the Auto-advance fileset information dialog box, click the Automatically retrieve header data 

for all images but the first check box found at the bottom of the screen. 
d) From the left panel of the dialog box, navigate to the folder containing the photos  to analyze.  
 
 V:\OPTICAL\region\year\island\REA\FISH\site\PHOTO_QUADS\analyst\ADJUSTED 
 
e) Select all of the images to be analyzed and click Start file processing. 
 
 

5. HEADER DATA: On the Point count header information window, the following fields need to be 
populated under the Photo/Analysis Information:  

 
a) Analyst: enter the analyst initials as they are stored in the database 

  Analysis date: enter the current date in the format MM/DD/YYYY 
  Institution: enter your affiliated institution.  
  For the majority of the analysts, enter “CRED”.  
  For subcontractors, enter “CRED contractor”.  
  For student interns/volunteers, enter “CRED intern”.  
 

b) After the 3 fields have been populated, click the Save and cache header data 
c) Click OK and click the Close button on the Point count header information window.  

 
 
6. CONFIGURE CPCe with the following settings: 
 

a) Verify CPCe will use the proper area in each photograph for analysis. The edges of survey 
photos will be excluded from analysis due to distortion. 

  
1.    Under the Mark border menu, select Mark/remark region border. 
2.    In the Marking the border warning dialog box, click the Yes button, acknowledging this 

action will cause existing analysis points to be erased. This is acceptable, as no 
classification has yet been performed on this photo set. 

2.    In the Specify the border boundaries dialog box, select Specify border offset 
(pixels). 

3.    Enter 60 in the X-offset window, 42 in the Y-offset window and then click the OK 
button.  

4.    A rectangle should appear on the image, inset from the edges, and the classification 
points should appear only within the rectangle. You can change the color of the rectangle 
by clicking on Options in the menu bar, then Data point graphical parameters. In the 
Data point color options box, click on "Frame border" and select the desired color from 
the color palette. Click the "OK" button and then "OK" button again 

  
*Useful Information 

By specifying an image boundary other than the entire image, CPCe will display the Specify the border boundaries 
window each time a new image is opened for analysis. CPCe remembers the previously-entered X-offset and Y-offset, 
so you merely need to press the OK button to continue. 

  
b) Verify CPCe will randomly distribute 10 points per photo. 

 
1. Under the Point Overlay menu, select Specify/apply overlay points. 
2. In the Data point positions dialog box, select Stratified random. 
3. Number of rows, type 2. 
4. Number of columns, type 5. 
5. Number of random points per cell, type 1. 
6. Click the Overlay points button 



	  

	  

c) Under the Options menu, check: 
 Number symbols 
 Auto-advance point 
 Auto-follow 
 Maintain zoom  

 
d) Under the Options menu, select Data point graphical parameters. 

1. Select Circle/crosshairs. 
2. In the Diameter text box, type 12 and click the OK button.  

  Click the OK button again verifying the selected options.  
 
 
*Useful Information 
CPCe remembers/uses the image boundary and point symbol settings from steps 8a-8d each time the program is run. So, 
these steps will not need to be implemented again unless directed to do so. 
 
 
 

7.   BEGIN ANALYSIS 
 

a) In the Point Data dialog box on the right of the CPCe screen, click in the 1st row in the ID (i.e. left-
hand) column.   

b) The analysis point 1 on the image will change to the color designated for "current focus data 
point" (aqua by default).   

c) Decide which benthic category lies directly underneath this point’s cross-hair and click on this 
category from  the classification buttons at the bottom of the screen. The category code is 
automatically entered in the cell, and the data point changes to the color chosen for "assigned 
data point" (red by default). 

d) The cursor automatically advances to the next point. 
e) Repeat 7 a-d until all points on the image are classified 
f) For guidance on selecting the correct category, please see IMAGE ANALYSIS GUIDELINES  
 

8. Click the right arrow button  ("Next file in dataset") beneath the Point Data dialog box, which 
scrolls to the next image selected for analysis. 

 
9. Repeat steps 7-8 to continue analyzing and saving additional images in the photo set. 
 
 
 
10. SAVING THE DATA 

 After analyzing the last image on the photo set, click on the  floppy disk icon at the bottom right 
of the Point Data dialog box ("save data to file"). 

 
a) In the Save data to .cpc file dialog box, navigate to the ADJUSTED folder containing the analyzed 

images: 
  
 V:\OPTICAL\region\year\island\REA\team\site\PHOTO_QUADS\analyst\ADJUSTED  
 
b) In the File name text box, double-check that the name of the file to be saved matches the site 

photo_id.cpc format. 
c) Click the Save button. 
 
* Please be advised: 
The starting directory displayed in the Save data to .cpc file dialog box may not be the appropriate ADJUSTED folder hierarchy 
(and most likely the ADJUSTED folder from the previously analyzed site). Just like Word or any other Windows application, the 
Save dialog window has to have a starting directory to display when saving a new file.  CPCe, especially when started for the 
first time, has no "memory" of previous directories where files have been opened or saved.  So, it defaults to a directory that it 



	  

	  

does remember; the directory in which it was installed on the C: drive.  Please take your time and navigate to the proper 
ADJUSTED folder on the V: drive. 

 
** Do not move files once image analysis has begun! 
Due to the way CPCe stores data in its .cpc files, please do not change the location of the code file, .jpg, or .cpc files once 
analysis on a photo set has begun. Doing so will create many data processing problems. 

 
 
11. EXPORT CPCe RESULTS FILES 
  
 When all photos in the set have been analyzed, export the classification data to Microsoft Excel: 
 

a) Under the File menu, select the Save pull-down menu. 
b) Select Save .cpc file(s) to Excel. 
c) Close any currently running Excel programs and click the OK button. 
d) In the Batch processing of .cpc files into Excel dialog box, on the left panel, ensure that the 

appropriate ADJUSTED folder has been selected. If not, navigate to the correct folder where 
the analyzed .cpc files are stored. 

e) Click Select all files. 
f) Select New Excel workbook and type the site name in the “Transect name” box (e.g. HAW-487) 
g) Select Create a .csv file. 
h) Select Database friendly column names.  
i) Ensure that Place each .cpc file in its own transect is NOT checked 
j) Ensure Archive is selected in the Optional Excel outputs section of the dialog box.  This is new in 

CPCe version 4.1. 
k) Click the Process files button. 
l) When prompted to ‘Specify format of saved Excel workbook’, select .xlsx (Open XML) 
m) After a few moments of processing, the New Excel Workbook window appears.   
n) Make sure to navigate to the appropriate RESULTS folder  
o) In the File name text box, type the name of the site from which these photos were analyzed 

(Example: HAW-487) 
 

* Note  
A common mistake that analysts have made in the past was to include the survey year suffix to the site name when 
naming the results workbooks (Example: HAW-487_2013). Follow the proper naming convention to minimize errors in the 
data QAQC process. 

 
p) Click the Save button. 
q) Click the OK button when notified the files have been saved. 

 
 
12. VERIFY THE FOLLOWING: 
 

a) Verify that two spreadsheets with the file extensions .xlsx and.csv were saved to the appropriate 
RESULTS folder  

 
 V:\OPTICAL\region\year\island\REA\team\site\PHOTO_QUADS\analyst\RESULTS. 
 
b) Verify that both spreadsheets were named with the proper naming convention (e.g. HAW-

487.xlsx and HAW-487.csv) 
 
c) Open the Excel workbook (.xlsx) and verify that it is properly formatted. In particular, verify the 

existence of the site_imgsummary and _archive worksheets.  If those worksheets are not 
present, delete the Excel workbook, repeat step 11, and at step 11-i, ensure Place each .cpc file 
in its own transect is not selected, and at step 11-j, ensure Archive is selected in the Optional 
Excel outputs section of the dialog box. 
 

d) While viewing the Excel workbook (.xlsx), select the _archive worksheet and scroll through the 



	  

	  

“Institution”, “Analysis_Date” and “Analysis_Tech” columns from rows 2 to 301 to ensure that all 
cells have been populated. If not, go to column “File_Name” and navigate to the .cpc file with the 
missing header data. Repeat steps 5, 10, 11 and 12.  
 
 

13. UPDATE THE TRACKING LOG to indicate that image analysis for that set has been completed.  
 To update the tracking log: 
  

a) Navigate to the CRED wiki: Benthic Image Analysis - Assignments 
b) Click on the appropriate production series (e.g. Stratified Random - MHI 2013) 
c) On the upper right side, click Edit 
d) Find the completed Site Name (e.g. HAW-487) and update the ANALYSIS_COMPLETED field 

with the date the CPCe Excel results workbook was exported 
e) Type any comments relating to the images in the NOTES field. Information that is applicable to 

enter in this field are: # of images analyzed; which images are of poor quality and were discarded; 
any info that the coordinator/data management team need to be aware of. 

f) On the GIANT CLAMS column, regardless of whether the point landed on the giant clam mantle 
or not, record the name of the image where a giant clam/s was observed.  
 
 
 
 

 
 
 
 
*If you have any difficulties/question regarding the tracking, please contact Paula Misa.  

 
 
 
II. IMAGE ANALYSIS GUIDELINES 
 

1) REFERENCES 
 Several references are available on the CRED Wiki and other websites: 
 Classification Tiers, Categories, Definitions for Tiers 1 and 2 
 Dichotomous Key for the Classification of Benthic Functional Groups 
 Annotated Training Images 
 Tier 3 coral codes  

AIMS Coral Fact Sheets 
 Guam Reef Life 
 
 ***Note 

Beginning 2013, CRED BIA has transitioned to analyzing images at a finer taxonomic level. Additional references will 
soon be added to the CRED Wiki to help make classification decisions  at this level. In the meantime, please refer to field 
guides (Veron, Erhardt & Knop, Fenner) or the above web links.    

 
 
2) WHEN IN DOUBT 

When in doubt, leave the point blank until you can consult with an expert or colleague who is 
familiar with the area.  If a subject matter expert is not available and/or you're still not able to 
confidently classify the point, use the Unclassified category.  Do not guess if you're not able to 
confidently classify the point. 

 
 
3) RELAYING NEW POINTS 

If any photo has more than 5 combined points classified as Shadow or Unclassified, please 



	  

	  

do not save those data. Rather, generate a new set of points to analyze by using the Point 
Overlay menu and selecting Recalculate point coordinates. Click the Yes button in the window 
warning that previous data for that image will be erased. Repeat this step no more than 3 times 
before discarding the photo altogether. Remember, 3 strikes and you're out. 

 
 
4) POOR IMAGE QUALITY 

In rare cases for sites with images whose quality is insufficient for use, 50% (15) images is the 
minimum acceptable number that needs to be analyzed to grant retention of those data in the 
production series. Any site with < 50% of analyzable images probably introduces more bias than 
reliable data and thus should be excluded from the analysis. 

 
 
5) MULTIPLE GROWTH FORMS 
   
 If analyzing to a finer taxonomic resolution: 

Refer to the Tier 3 codes spreadsheet that maps Tier 3 (genus/species) to its corresponding, 
fixed, Tier 2 (functional group) category  

 
 If analyzing to functional groups:  
 Classify the coral colony based on the morphology directly under the point rather  than the overall 

colony morphology 
 

 
6)  POINT BETWEEN TWO BENTHIC CATEGORIES 

If a point falls precisely between multiple coral growth morphologies, or on the border between 
multiple benthic categories (e.g., coral-algae), the benthic category occupying the greatest area 
within the symbol (circle wrapping the cross-hairs) will be classified. Additionally, if the multiple 
benthic categories occupy equal space within the symbol, the benthos falling on the top left 
quadrant within the point symbol will be classified. 

 
 

7) UNCLASSIFIED/UNKNOWN, SHADOW, WATER COLUMN 
The category Shadow should be used when the point falls on an area that is dark and the nature 
of the benthos cannot be assessed due to diminished light.  
The category Unclassified should be used when the nature of the benthos cannot be determined 
due to image quality or unfamiliarity with the type of benthos.  
In rare cases when the point falls on the water column, classify the point as TAPE in order to 
remove that point from the benthic cover estimate. (Note: the categories Tape and Wand are 
excluded from percent cover estimates). 

  
 

8)  NOTES COLUMN 
 

For points classified as Hard Coral, record any occurrence of coral bleaching 
and COTS predation by using the BLE and PRED buttons.  

a) In the Point Data dialog box on the right of the CPCe screen, click in 
the NOTES (i.e. right-hand) column for the point(s) that have either 
bleaching or COTS predation. 

b) Click the NOTES classification button as appropriate. 
c) Only the buttons (in white) found on the lower right portion of the 

screen can be designated to the Notes column area. 
d) A bleached coral should be classified first by the appropriate growth 

morphology/taxon. 
e) COTS predation scars on corals should be classified as hard substrate 

(non-visible turf). 



	  

	  

9)  NAVIGATION TIPS 
 

a) You can enlarge the view under an active point by left-clicking on the image. Return to the 
normal view by right-clicking. 

b) You can hide all of the random points on the image to get an unobstructed view by clicking on 
the "eye" icon at the bottom of the point data column. Click again to show the points. 

c) You can turn off all of the random points except the one to be classified by using the 
"isolation mode" (sun-looking) icon at the bottom right of the Point Data dialog box. 

d) If the benthos in the image is simple (e.g. sand with a few small rubble areas) in which most 
points have the same classification (e.g. sand), you can categorize those few points that are 
different (e.g. rubble). Then click on the icon on the upper left of the Point Data dialog box 
("select all points with blank ID fields"), and choose their classification (e.g. sand). All those 
fields will be classified in one batch. 

    
 
              ______________________________END (August 2014)_______________________________ 
 
Version Documentation: 
 
V.2 - August 2014 (c/o Paula Misa, Bernardo Vargas-Angel, Brett Schumacher) 
The following steps have been modified with the August 2014 version of the SOP: 

• Removed steps specific to analysis of images from towed-diver surveys 
• Removed “checking out process” from the CRED Wiki 
• Reorganized steps and moved image analysis tips and guidelines to the bottom of the document 
• Revised SOP to reflect CRED’s transition to analyzing images at a finer taxonomic order (e.g. new code file; addition of 

corals under the proposed ESA list under the NOTES column; addition of the Tier 3 code.xlsx as reference, etc.) 
• Added guidelines when populating the Header Data. In particular the institution to enter when the analyst is non-CRED. 
• Updated guideline instructions for setting computer resolution prior to CPCe use.  
• Added protocol to ensure that all “Header Data” have been populated 
• Added protocol to specific .xlsx (Open XML) as the Excel spreadsheet file format 
• Added steps to add a border on the image to prevent points from being distributed on the edge of the image where 

aberrations/distortions are likely to occur 
• Added a protocol when analyzing a photoset where <50% of the images are of poor quality/insufficient for use 
• Added a protocol to note the file name of images where giant clams were observed in the Wiki tracking log 

 
 
V.1 - December 2011 (c/o Jeff Anderson) 
The following steps have been changed with the Dec. 2011 version of the Benthic Image Analysis SOP: 

• Steps 1 & 17 for checking-out and checking-in photo set analysis and completion. 
• Step 2.a.iii or 2.b.iii for adding the folder layer with your diver database initials. 
• Step 4 for new CPCe version 4.12. 
• Step 12.b for handling situations when more than 5 Unclassified/Shadow points occur in an image and/or tows that have 

several photos of poor quality. 
• Steps 16.i & j for new options to select when creating the Excel results workbooks. 


